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1.  OVERVIEW

The TCP/IP Development Kit provides a hardware platform

based on the Rabbit 2000® microprocessor, Dynamic C®, and

the tools necessary to develop a robust 10Base-T Ethernet appli-

cation.

1.1   Description

The TCP/IP Development Kit includes a TCP/IP Development Board (with a Rabbit 

2000® microprocessor, flash memory, SRAM, Ethernet hardware, serial ports, digital I/O), 

Dynamic C development software with TCP/IP stack and documentation on CD-ROM 

(not a trial version!), a demonstration board, a power supply, and a serial programming 

cable.

The TCP/IP Development Board included in the kit allows for immediate evaluation and 

development of TCP/IP applications using the Rabbit 2000 microprocessor. Executable 

code can be downloaded into flash memory or SRAM (an optional battery backup board 

for SRAM and the real-time clock is available). Two communication ports are available—

an RS-232 port and a RS-485 port. Other features of the TCP/IP Development Board 

include four high-current outputs, four digital inputs, seven timers, a real-time battery-

backable clock, and a 10Base-T Ethernet interface.

1.1.1  TCP/IP Development Board Features

• 18.432 MHz Rabbit 2000 Processor

• 10Base-T Ethernet interface

• 4 high-current outputs (200 mA @ 40 V DC)

• 4 digital input points (0–5 V DC nominal)

• RS-232 serial port

• RS-485 serial port (may be factory configured to second RS-232)

• 512K flash memory (2 × 256K)

• 128K SRAM

• 7 built-in timers

• Time/date real-time clock (requires battery-backup board, available separately)

• Watchdog timer



2 TCP/IP Development Kit

1.1.2  Key Benefits

• Ethernet ready—port to an Ethernet chip is done for the Rabbit 2000 chip. 

• Cost-effective—no run-time royalties. 

• Simplified development—a complete Dynamic C software package (with integrated 

editor, compiler and debugger) is provided. No in-circuit emulator is required. 

• A head start—sample programs, including HTTP Web server and SMTP mail client, 

provide an advanced starting point for development. 

• Quick development time—full hardware reference schematics help reduce develop-

ment efforts. 

1.1.3  TCP/IP Capabilities

• Socket-Level TCP (Transmission Control Protocol) provides reliable full-duplex data 

transmission. 

• Socket-Level UDP(User Datagram Protocol)—simple protocol exchanges datagrams 

without acknowledgements or guaranteed delivery. 

• ICMP (Internet Control Message Protocol)—network-layer Internet protocol that 

reports errors and provides other information relevant to IP packet processing.

• DNS (Domain Name System) client—a distributed Internet directory service that is 

used mostly to translate between domain names and IP addresses, and to control Inter-

net e-mail delivery.

•  DHCP (Dynamic Host Configuration Protocol) client—provides a framework for pass-

ing configuration information to hosts on a TCP/IP network. DHCP is based on the 

Bootstrap Protocol (BOOTP), adding the capability of automatic allocation of reusable 

network addresses and additional configuration options.

• HTTP (Hypertext Transfer Protocol) server—the protocol used by Web browsers and 

Web servers to transfer files, such as text and graphic files. Includes facilities for Server 

Side Includes (SSI) and CGI routines. 

• SMTP (Simple Mail Transfer Protocol) client—Internet protocol providing e-mail ser-

vices. 

• FTP  (File Transfer Protocol) server and client—application protocol, part of the 

TCP/IP protocol stack, used for transferring files between network nodes. Server with 

password support for file transfers between network nodes available on the Rabbit 

2000. 

• TFTP (Trivial File Transfer Protocol) server and client—simplified version of FTP that 

allows files to be transferred from one computer to another over a network.

• POP3 (Post Office Protocol) client.

• Serial-to-Telnet gateway.

Additional TCP/IP capabilities are added on an ongoing basis.
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1.2  Physical and Electrical Specifications

Table 1 lists the basic specifications for the TCP/IP Development Board.

The TCP/IP Development Board has 15 pins on header J7, one RJ-12 jack for RS-232 or 

RS-485 serial communication, and one RJ-45 Ethernet jack. The pinouts are shown in Figure 1.

Figure 1.  TCP/IP Development Board I/O Pinout

RJ-45 pinouts are sometimes numbered opposite to the way shown in Figure 1. Regardless 

of the numbering convention followed, the pin positions relative to the spring tab position 

(located at the bottom of the RJ-45 jack in Figure 1) are always absolute, and the RJ-45 

connector will work properly with off-the-shelf Ethernet cables.

Table 1.  TCP/IP Development Board Specifications

Specification Data

Power Supply  9 V to 40 V DC

Board Size (with optional 

backup-battery board)

4.30" × 4.71" × 0.79"

(109 mm × 120 mm × 20 mm)

Environmental –40°C to 70°C, 5–95% humidity, noncondensing
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1.3  Development Software

The TCP/IP Development Board uses the Dynamic C development environment for rapid 

creation and debugging of runtime applications. Dynamic C provides a complete develop-

ment environment with integrated editor, compiler and source-level debugger. It interfaces 

directly with the target system, eliminating the need for complex and unreliable in-circuit 

emulators.

Dynamic C must be installed on a Windows workstation with at least one free serial 

(COM) port for communication with the target system. See Chapter 3., “Installing 

Dynamic C,” for complete information on installing Dynamic C.

TCP/IP source code is provided in addition to the Dynamic C software on CD-ROM. 

ICMP, HTTP (includes facilities for SSI, CGI routines, cookies, and basic authentication), 

SMTP, FTP, and TFTP (client and server) capabilities are provided. Ethernet drivers for 

the RealTek Ethernet chip are also included. Users can directly write to TCP or UDP sock-

ets to develop custom applications. In addition, extensive sample programs are provided 

to assist with development. No run-time royalties are required, leading to significant cost 

savings for OEMs over the life of their application.
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1.4  How to Use This Manual

This Getting Started manual is intended to give users a quick but solid start with the 

TCP/IP Development Board. It does not contain detailed information on the hardware 

capabilities or the Dynamic C development environment. Most users will want more 

detailed information on some or all of these topics in order to put the TCP/IP Development 

Board to effective use.

TIP: We recommend that anyone not thoroughly familiar with single-board computers at 

least read through the rest of this manual to gain the necessary familiarity to make use 

of the more advanced information.

1.4.1  Additional Reference Information

Several higher level reference manuals are provided in HTML and PDF form on the 

accompanying CD-ROM. Advanced users will find these references valuable in develop-

ing systems based on the TCP/IP Development Board:

• Dynamic C User’s Manual

• Dynamic C Function Reference Manual

• Dynamic C TCP/IP User’s Manual

• Rabbit 2000 Microprocessor User’s Manual

• An Introduction to TCP/IP

1.4.2  Using Online Documentation

We provide the bulk of our user and reference documentation in two electronic formats, 

HTML and Adobe PDF. We do this for several reasons.

We believe that providing all users with our complete library of product and reference 

manuals is a useful convenience. However, printed manuals are expensive to print, stock, 

and ship. Rather than include and charge for manuals that every user may not want, or pro-

vide only product-specific manuals, we chose to provide our complete documentation and 

reference library in electronic form with every Development Kit and with our Dynamic C 

development environment.

Finding Online Documents

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, create a new desktop icon that points to default.htm in the 

docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.
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Printing Electronic Manuals

We recognize that many users prefer printed manuals for some uses. Users can easily print 

all or parts of those manuals provided in electronic form. The following guidelines may be 

helpful:

• Print from the Adobe PDF versions of the files, not the HTML versions.

NOTE: The most current version of Adobe Acrobat Reader can always be downloaded 

from Adobe’s web site at http://www.adobe.com. We recommend that you use version 

4.0 or later.

• Print only the sections you will need to refer to often.

• Print manuals overnight, when appropriate, to keep from tying up shared resources dur-

ing the work day.

• If your printer supports duplex printing, print pages double-sided to save paper and 

increase convenience.

NOTE: If you do not have a suitable printer or do not want to print the manual yourself, 

most retail copy shops (e.g., Kinkos, AlphaGraphics, etc.) will print the manual from the 

PDF file and bind it for a reasonable charge—about what we would have to charge for a 

printed and bound manual.
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1.5  CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30–230 MHz. The limits are 7 dB higher for frequencies 

above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based 

systems at frequencies above 300 MHz are generally well below background noise levels.

The TCP/IP Development Board has been tested and was found to be in 

conformity with the following applicable immunity and emission stan-

dards.Boards that are CE-compliant have the CE mark.

NOTE: Earlier versions of the TCP/IP Development Board sold 

before 2003 that do not have the CE mark are not CE-complaint.

Immunity

The TCP/IP Development Board meets the following EN55024/1998 immunity standards.

• EN61000-4-2 (ESD)

• EN61000-4-3 (Radiated Immunity)

• EN61000-4-4 (EFT)

• EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.

Emissions

The TCP/IP Development Board meets the following emission standards emission standards 

with the Rabbit 2000 spectrum spreader turned on and set to the normal mode. The spec-

trum spreader is only available with Rev. C or higher of the Rabbit 2000 microprocessor. 

This microprocessor is used on the TCP/IP Development Boards that carry the CE mark.

• EN55022:1998 Class B

• FCC Part 15 Class B

Your results may vary, depending on your application, so additional shielding or filtering 

may be needed to maintain the Class B emission qualification.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:

less than 40 dB µV/m at 10 m

(40 dB relative to 1  µV/m) or 300 µV/m

More restrictive emissions requirement:

30 dB µV/m at 10 m or 100 µV/m
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1.5.1  Design Guidelines

Note the following requirements for incorporating the TCP/IP Development Board into 

your application to comply with CE requirements.

General

• The power supply provided with the Development Kit is for development purposes 

only. It is the customer’s responsibility to provide a CE-compliant power supply for the 

end-product application.

• When connecting the TCP/IP Development Board to outdoor cables, the customer is 

responsible for providing CE-approved surge/lighting protection.

• Rabbit Semiconductor recommends placing digital I/O or analog cables that are 3 m or 

longer in a metal conduit to assist in maintaining CE compliance and to conform to 

good cable design practices.

• When installing or servicing the TCP/IP Development Board, it is the responsibility of 

the end-user to use proper ESD precautions to prevent ESD damage to the TCP/IP 

Development Board. 

Safety

• All inputs and outputs to and from the TCP/IP Development Board must not be con-

nected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC).

• The lithium backup battery circuit on the TCP/IP Development Board has been designed 

to protect the battery from hazardous conditions such as reverse charging and excessive 

current flows. Do not disable the safety features of the design.

1.5.2  Interfacing the TCP/IP Development Board to Other Devices

Since the TCP/IP Development Boards are designed to be connected to other devices, good 

EMC practices should be followed to ensure compliance. CE compliance is ultimately the 

responsibility of the integrator. Additional information, tips, and technical assistance are 

available from your authorized Rabbit Semiconductor distributor, and are also available 

on the Z-World Web site at www.zworld.com.
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2.  HARDWARE CONNECTIONS

Chapter 2 explains how to connect the power supply to the

TCP/IP Development Board and how to connect the program-

ming cable to your PC. Once you run a sample program to dem-

onstrate that you have connected everything correctly, you will

be ready to go on and finish developing your system.

2.1  Development Kit Contents

The TCP/IP Development Kit contains the following items:

• TCP/IP Development Board with 512K flash memory and 128K SRAM.

• Demonstration Board with pushbutton switches and LEDs, used to demonstrate I/O and 

TCP/IP capabilities.

• Wire assembly to connect Demonstration Board to TCP/IP Development Board.

• Set of 4 rubber foot pads to position TCP/IP Development Board.

• Wall transformer power supply, 12 V DC (included only with Development Kits sold 

for the North American market—overseas users will need a power supply compatible 

with their local mains power).

• 10-pin header to DE9 programming cable with integrated level-matching circuitry.

• Dynamic C CD-ROM, with complete product documentation on disk.

• This Getting Started manual.

• Registration card.
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2.2  Connections

1. Attach the rubber feet to the bottom corners of the TCP/IP Development Board.

2. Connect the Programming Cable to the TCP/IP Development Board

Turn the Rabbit 2000 TCP/IP Development Board so that the Rabbit 2000 microprocessor 

is facing up as shown below. Connect the 10-pin PROG connector of the programming 

cable to header J4 onthe TCP/IP Development Board as shown in Figure 2. Be sure to ori-

ent the red edge of the cable towards pin 1 of the connector. (Do not use the DIAG connector, 

which is used for a normal serial connection.) Connect the other end of the programming 

cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. If your PC has no RS-232 

COM port, but has a USB port, you should buy an RS-232/USB converter from 

Z-World’s Web store.

Figure 2.  Connecting Power and PC to TCP/IP Development Board
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3. Connect Power Supply to TCP/IP 

Development Board

Connect the positive lead (indicated with red 

heat-shrink tubing) to the PWR connector on 

header J7 on the TCP/IP Development Board 

and connect the negative lead to GND on 

header J7 as shown here.

NOTE: Be careful to hook up the 

positive and negative power leads 

exactly as described. Otherwise, the 

TCP/IP Development board will not 

function.

4. Apply Power

Plug in the wall transformer. The TCP/IP Development Board is now ready to be used.

NOTE: A hardware RESET is accomplished by unplugging the AC adapter, then plug-

ging it back in.

Figure 3.  Power Supply Connections
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2.3  Where Do I Go From Here?

We recommend that you proceed to the next chapter and install Dynamic C (if you do not 

already have it installed), then run the first sample program to verify that the TCP/IP 

Development Board is set up and functioning correctly.

If everything appears to be working, we recommend the following sequence of action:

1. Run all of the sample programs described in Chapter 4 to get a basic familiarity with 

Dynamic C and the TCP/IP Development Board’s capabilities.

2. A documentation icon should have been installed on your workstation’s desktop; click 

on it to reach the documentation menu. You can create a new desktop icon that points to 

default.htm in the docs folder in the Dynamic C installation folder.

3. For advanced development topics, refer to the Dynamic C User’s Manual, also in the 

online documentation set.

2.3.1  Technical Support

NOTE: If you purchased your TCP/IP Development Board through a distributor or 

through a Z-World or Rabbit Semiconductor partner, contact the distributor or Z-World 

partner first for technical support.

If there are any problems at this point:

• Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at 

www.zworld.com/support/bb/.

• Use the Technical Support e-mail form at www.zworld.com/support/support_submit.html.
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3.  INSTALLING DYNAMIC C

To develop and debug programs for the TCP/IP Development

Board (and for all other Z-World and Rabbit Semiconductor

hardware), you must install and use Dynamic C. This chapter

takes you through the installation of Dynamic C, and then pro-

vides a tour of its major features with respect to the TCP/IP

Development Board.

3.1  An Overview of Dynamic C

Dynamic C integrates the following development functions into one program:

• Editing

• Compiling

• Linking

• Loading

• Debugging

In fact, compiling, linking and loading are one function. Dynamic C does not use an In-

Circuit Emulator; programs being developed are downloaded to and executed from the 

“target” system via an enhanced serial-port connection. Program development and debug-

ging take place seamlessly across this connection, greatly speeding system development.

Other features of Dynamic C include:

• Dynamic C has an easy-to-use built-in text editor. Programs can be executed and 

debugged interactively at the source-code or machine-code level. Pull-down menus and 

keyboard shortcuts for most commands make Dynamic C easy to use.

• Dynamic C also supports assembly language programming. It is not necessary to leave 

C or the development system to write assembly language code. C and assembly lan-

guage may be mixed together.

• Debugging under Dynamic C includes the ability to use printf commands, watch 

expressions, breakpoints and other advanced debugging features. Watch expressions 

can be used to compute C expressions involving the target’s program variables or func-

tions. Watch expressions can be evaluated while stopped at a breakpoint or while the 

target is running its program.
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• Dynamic C provides extensions to the C language (such as shared and protected vari-

ables, costatements and cofunctions) that support real-world embedded system devel-

opment. Interrupt service routines may be written in C. Dynamic C supports 

cooperative and preemptive multi-tasking.

• Dynamic C comes with many function libraries, all in source code. These libraries sup-

port real-time programming, machine level I/O, and provide standard string and math 

functions.

• Dynamic C compiles directly to memory. Functions and libraries are compiled and 

linked and downloaded on-the-fly. On a fast PC, Dynamic C can load 30,000 bytes of 

code in 5 seconds at a baud rate of 115,200 bps.

3.2  System Requirements

To install and run Dynamic C, your system must be running one of the following operating 

systems:

• Windows 95

• Windows 98

• Windows NT

• Windows Me

• Windows 2000

• Windows XP

3.2.1  Hardware Requirements

The PC on which you install Dynamic C should have the following hardware:

• A Pentium or later microprocessor

• 32 MB of RAM

• At least 40 MB of free hard drive space

• At least one free COM or USB* (serial) port for communication with the target systems

• A CD-ROM drive (for software installation)

*. RS-232/USB converter required.
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3.3  Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web 

sites

• www.zworld.com/support/

or

• www.rabbitsemiconductor.com/support/

for the latest patches, workarounds, and bug fixes.

3.3.1  Add-On Modules

Dynamic C installations are designed for use with the board they are included with, and 

are included at no charge as part of our low-cost kits. Z-World offers add-on Dynamic C 

modules for purchase, including the popular µC/OS-II real-time operating system, as well 

as PPP, Advanced Encryption Standard (AES), and other select libraries.

In addition to the Web-based technical support included at no extra charge, a one-year 

telephone-based technical support module is also available for purchase.
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3.4  Installing Dynamic C

Insert the Dynamic C CD-ROM in the drive on your PC. If autorun is enabled, the CD 

installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows 

Start > Run menu or Windows Disk Explorer to launch SETUP.EXE from the root folder 

of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory and not covered in this section. Selected steps that may be 

confusing to some users are outlined below. (Some of the installation utility screens may 

vary slightly from those shown.)

3.4.1  Program & Documentation File Location

Dynamic C’s application, library and documentation files can be installed in any conve-

nient location on your workstation’s hard drives.

The default location, as shown in the example above, is in a folder named for the version 

of Dynamic C, placed in the root folder of the C: drive. If this location is not suitable, enter 

a different root path before clicking Next >. Files are placed in the specified folder, so do 

not set this location to a drive’s root directory.
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3.4.2  Installation Type

Dynamic C has two components that can be installed together or separately. One compo-

nent is Dynamic C itself, with the development environment, support files and libraries. 

The other component is the documentation library in HTML and PDF formats, which may 

be left uninstalled to save hard drive space or installed elsewhere (on a separate or net-

work drive, for example).

The installation type is selected in the installation menu shown above. The options are:

• Typical Installation — Both Dynamic C and the documentation library will be 

installed in the specified folder (default).

• Compact Installation — Only Dynamic C will be installed.

• Custom Installation — You will be allowed to choose which components are installed. This 

choice is useful to install or reinstall just the documentation.
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3.4.3  Select COM Port

Dynamic C uses a COM (serial) port to communicate with the target development system. 

The installation allows you to choose the COM port that will be used.

The default selection, as shown in the example above, is COM1. You may select any avail-

able port for Dynamic C’s use. If you are not certain which port is available, select COM1. 

This selection can be changed later within Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-

fying a port in use by another device (mouse, modem, etc.) may cause temporary prob-

lems when Dynamic C is started.

3.4.4  Desktop Icons

Once your installation is complete, you will have up to three icons on your PC desktop, as 

shown below.

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.
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3.5  Starting Dynamic C

Once the TCP/IP Development Board is set up and connected as described in Chapter 2 

and Dynamic C has been installed, start Dynamic C by double-clicking on the Dynamic C 

icon. Dynamic C defaults to using the serial port on your PC that you specified during 

installation. If the port setting is correct, Dynamic C should detect the TCP/IP Develop-

ment Board and go through a sequence of steps to cold-boot the TCP/IP Development 

Board and to compile the BIOS. (Some versions of Dynamic C will not do the initial BIOS 

compile and load until the first time you compile a program.)

If you receive the message beginning “BIOS successfully compiled …” you are ready to 

continue with the sample programs in the next chapter.

3.5.1  Communication Error Messages

If you receive the message No Rabbit Processor Detected, the programming 

cable may be connected to the wrong COM port, a connection may be faulty, or the target 

system may not be powered up. First, check both ends of the programming cable to ensure 

that it is firmly plugged into the PC and the programming port.

If there are no faults with the hardware, select a different COM port within Dynamic C. 

From the Options menu, select Communications. Select another COM port from the list, 

then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C 

still reports it is unable to locate the target system, repeat the above steps until you locate the 

active COM port. You should receive a Bios compiled successfully message 

once this step is completed successfully. 

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Choose a lower debug baud rate.
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3.6  PONG.C

You are now ready to test your set-up by running a sample program.

Find the file PONG.C, which is in the Dynamic C SAMPLES folder. To run the program, 

open it with the File menu (if it is not still open), compile it using the Compile menu, and 

then run it by selecting Run in the Run menu. The STDIO window will open and will dis-

play a small square bouncing around in a box.

This program does not test the TCP/IP part of the board, but does ensure that the board is 

functional. The sample program in the next chapter tests the TCP/IP portion of the board.
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3.7  Sample Programs

Sample programs are provided in the Dynamic C Samples directory. The various subdi-

rectories contain specific sample programs that illustrate the use of the corresponding 

Dynamic C libraries. The sample program PONG.C demonstrates the output to the STDIO 

window. The ICOM and TCPIP folders provide sample programs specific to the TCP/IP 

Development Board.

The sample programs illustrate the topics associated with the TCP/IP Development Board. 

See An Introduction to TCP/IP for more information on these topics.

Each sample program has comments that describe the purpose and function of the program.

3.7.1  Running Sample Program DEMOBRD1.C

This sample program will be used to illustrate some of the functions of Dynamic C.

Before running this sample program, you will have to connect the Demonstration Board 

from the TCP/IP Development Kit to the TCP/IP Development Board. Proceed as follows.

1. Use the wires included in the TCP/IP Development Kit to connect header J1 on the 

Demonstration Board to header J7 on the TCP/IP Development Board. The connections 

are shown in Figure 4.

2. Make sure that your TCP/IP Development Board is connected to your PC and that the 

power supply is connected to the TCP/IP Development Board and plugged in as 

described in Section 2.2.

Figure 4.  Connections Between TCP/IP Development Board and Demonstration Board
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